Chapter 1: Creating Elements
Projects

In This Chapter

+ Understanding creations
~ Creating photo books

+~ Creating a calendar

~ Creating photo collages

~ Creating greeting cards

+ Creating photo stamps

1~ Creating CD/DVD labels
v Creating VCDs with menus
~ Creating flip books

A dobe Photoshop Elements offers you a number of creations that can
be shared onscreen or in print. From both the Create and Share panels
in the Panel Bin in the Organizer and from within both editing modes,

you have a number of menu choices for producing creations
designed for sharing.

In Book IX, Chapter 3, we look at creating files
for screen and Web viewing. In this chapter,
we talk about creations designed for print and
sharing.

Getting a Handle on Creations

In Book IX, Chapter 4, we talk about online albums,
attaching files to e-mail, using photo mail, creating
CDs and DVDs, and using online sharing services. All
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these creations offer different output options, such as e-mailing, burning
files to disc, and creating HTML documents — as well as printing and PDF
creation — and you create all of them using the Share panel.

You work with the remaining
creations — photo books, photo col-
lages, photo calendars, greeting cards,
print labels, and photo stamps — by
choosing options from the Create
panel shown in Figure 1-1. All these
creations are designed for output to
your printer or for sending files to an

CREATE SHARE

What would you like to create?

= Photo Book...

online printing service, or to friends i2§ PhotoCalendar...
and family.
Photo Collage...
“&N\BER When you make a creation that will el cotegs
& ultimately be sent to an online service
or shared with other users, keep in 7 Slide Show...

mind that you first must select the
photos you want in your creation. For
example, creating a photo book by
clicking the Photo Book button in the
Create panel first requires you to let Mare Options >R
Elements know what photos are to be
used in your photo book. If you
happen to click a button and nothing
happens, more than likely, you haven’t
selected any photos.

- Order Prints ...

Order Kadak Photo Greeting Cards...

PhotoStamps® ...

‘Greeting Card...
CD Jacket...
DVD Jacket...
Many creation options follow a similar CD/DVD Label...
set of steps to produce a file that will
be shared with other users or sent to
an online printing service. In the Panel
Bin, you find all you need to make a
new project. It gives you choices for Figure 1-1: The Create panel.
layouts and producing a creation.

Some of the choices from both the Create and Share panels are

g 9@ g |

VCD with Menu...
Flipbook...

1 Layout options: Select some photos in the Organizer and click an item,
such as Photo Book, to make the Create panel change to the Project
view. This view displays some information about making a new creation.

1 Auto-Fill with Project Bin Photos: This check box is selected by
default, and the files you see in the Project Bin are added to your
project.
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v~ Include Captions: Select this check box if you want the photo captions
to appear on each page below their respective photos.

1~ Number of Pages: Elements automatically creates the number of pages
to accommodate the number of photos you selected in the Organizer.
Note that some creations require a minimum number of photos to
produce a project. Photo Book, for example, requires a minimum of
18 pages.

After assembling your creation, click the Create button. Elements then incor-
porates the selected photos into the layout and theme you specified in the
panel. Be patient and wait for Elements to complete the task.

After a creation has been made, the document appears like any other image
you open in Elements. You can crop, modify, print, and more. Using an
Elements file, you choose Filem>Save to open the Save As dialog box. Type a
name and click Save.

Creating a Photo Book

\\3

Elements provides some fancy ways to create pages for a photo album. The
Photo Book Creation panel offers many different options for choosing page
templates, adding artwork and type, printing your album pages, or sending
the files to an online service for professional printing.

Follow these steps to create a photo book:

1. Select files in the Organizer and click the Create tab.

The procedure for all creations is the same. You first select files in the
Organizer (or an editing mode) and then click the Create tab in the
Panel Bin. Ideally, it’s best to create an album, as we explain in Book II,
Chapter 2, and click the album to display the album photos in the
Organizer window. But remember, after you display an album in the
Organizer, you still need to select all the photos.

To select all photos shown in an Organizer window, press Ctrl+A.
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2. Click Photo Book in the Create panel.

The first pane in the Photo Book
Projects panel opens with the first
file you selected in the Organizer
appearing as an image thumbnail,
as shown in Figure 1-2. As you can
see in Figure 1-2, you also find
some help information to guide
you through the process for creat-

SHARE

Arbwork

ing a photo book. 1 order it. A
minimum of a
Regardless of whether you're
working in the Organizer or an Title Page Photo
editing mode, the Photo Book The title page may only have one photo. It will
option is available in the same be centered in a dic-ant window.
Create panel. The Create panel =
changes to the first of several A

P

panes that walk you through the
steps to create a photo book. If
you start in the Organizer, clicking
Photo Book in the Create panel
opens your selected photos in Full The Title Page photo is

Edit mode. Pro n. To ch
{ sorimport a

3. Choose a photo for the title page.

By default, the first photo in the
Project Bin in Full Edit mode is
the photo that’s used for the title
page in your photo book. To
change that photo to a different
image, drag the thumbnail image
in the Project Bin to the first

position. Figure 1-2: Click Photo Book in the Create

4. Click Next and choose a layout. panel, and the first pane in the Photo Book
Projects panel opens.

Choose either a random layout or

a particular layout from an assort-

ment of layout options. To choose a particular layout for the left and
right pages, for example, click the Choose Photo Layout radio button
and then click the layouts you want, as shown in Figure 1-3.
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CREATE SHARE
[ Arcwork
Photo Book
Layout Options

Random Photo Layout

@® Choose Photo Layout

Left Page Layout

Right Page Layout

Previous

Add photos to frames.

Figure 1-3: Select a layout.

5. Click Next in the Create panel to select a theme for your photo book.

The third pane in the Create panel provides options for choosing a
theme for your book pages. Select a theme from the scrollable list in the
panel, as shown in Figure 1-4.
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6. (Optional) Click the Include

Captions check box. CREATE SHARE
Follow this step only if you want [ Artwork
photo captions to appear below

your images. Photo Book
7. Click Create.

Wait a few minutes while Elements
lays out the page or pages and
shows a preview in the Image
window, as shown in Figure 1-5.

Choose a Theme

After the pages are created and
the photos are added to your
layout, you can use the various
options in the Projects panel to
tweak your pages with the help of
frames and drop shadows, by
adding text, adding clip art, or by
masking images with various sten-
cils. With each selection you make Include Captions
from the Project panel’s various
drop-down menus, the panel
changes to display choices for the
menu item selected.

Additional Options

v Auto-Fill with Project Bin Photos

Number of Pages | 20

8. (Optional) Add text to a page.

Use the Text tool in the special
Tools panel shown on the left side
of the photo book preview (refer Previous
to Figure 1-5) to add text to the
book pages.

9. As with any other Elements file,
choose File=>Save to save the
project.

Figure 1-4: Select a theme.

When you choose Filem>Save or Save As, you have an option to save
your photo book as a project or a PDF file. The default file type is Photo
Project Format (*. PSE). Open the Format drop-down list and you can
choose Acrobat PDF (*.PDF, *. PDP). If you choose PDF for the file
format, you can easily e-mail and share your photo book with others.
Recipients of your photo book only need the free Adobe Reader soft-
ware to view and print from it.
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Figure 1-5: The preview of the photo hook.

10. Choose an output option.

At the bottom right in Figure 1-5 you have buttons for printing the photo
book or ordering it. Click Print to open the Print dialog box where you
can print to your desktop printer. Click Order and you can place an
order using the Kodak EasyShare service. (For more on Kodak
EasyShare, see “Making a Photo Calendar” later in this chapter.)

All the options in the Artwork panel are used in the same manner. For exam-
ple, if you want to change the background artwork, choose Backgrounds
from the menu shown in Figure 1-6 — where you see the By Seasons drop-
down list. Click a background from the panel and drag the background to
the page you want to edit. (Note you can also select a background and click
the Apply button.) When adding frames and shadows to your pictures,
choose Frames from the menu and drag a frame to a picture on a page, or
select a frame and click Apply.

Elements provides you with many different editing options for creating the
design for your photo pages. Try to spend some time choosing different
options in the Artwork panel and drag items (or select them and click
Apply) to the pages to see how easy it is to change the appearance of your
photo book.

After you create a photo book, you can print the album pages to your desk-
top printer or click the Order button in the Image window. When you click
Order, you can place an online order for a professionally printed book that
will be mailed to you.
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When you edit an image on a photo page, a bar with two icons appears
above the image. The Check Mark icon is used to accept the edit you make.
The circle with a diagonal line represents a Cancel button. Click the button
to cancel your edits.

Making a Photo Calendar

Photo calendars are created using the Kodak EasyShare service. You select
photos in the Organizer (13 photos total if you want a cover photo and a
separate photo for each month). After selecting photos, click Photo
Calendar in the Create panel and the Kodak EasyShare logon page opens, as
shown in Figure 1-6.

Photo Calendar ...

Order Calendar Adobe Photoshop Services Provided by
Step: (Tiselect Photos Tuplosd (3 Creare KodakEas,Share Gallory

[ TID>
Cr

FiFst Hame

Email Address

Confirm Emai Address *

Fazsward *

Thera is no current {6 character mn)

procalion & this me. Canfirm Password *
Please check |ater. vl Remember my password

o S=nd me special affers and
news from the EasyShare
Galery and Kodak.

s Please send me information
and prometions on Adobe
products and services.

| | )agree to use the Kodak
EasyShare Galliery service In
accardance with the Terms of
Service.

See offer details

* Indicates a required fsld

2] £ Gancel [ x>
I ——

Figure 1-6: Kodak EasyShare logon page.

If you have a Kodak EasyShare account, click the Sign-in button and log on
to your account. If you don’t have an account, fill in the information on the
Sign-In pane and click Next to proceed. Your log-in and account information
will be e-mailed to you, and you can then log in to the service.

To create a calendar once you have a Kodak EasyShare account, do the
following:
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1. Select Photos in the Organizer.
If you want a cover and a photo for each month, select 13 photos.
2. Click Create and choose Photo Calendar.

3. In the new window that appears, log on to the Kodak EasyShare serv-
ice and click Next.

Your selected photos are uploaded to Kodak EasyShare. Wait until the
progress bar shown in Figure 1-7 completes the upload. When the upload
is completed the pane changes and informs you that your upload was
successful.

4. Click Next when you see your upload successfully completed.

Your default Web browser opens the adobe . kodakgallery Web page,
as shown in Figure 1-8.

5. Click Next and choose the fill method.

A pop-up window opens as shown in Figure 1-9 providing you some
information related to adding photos to your calendar. You can choose
to use the Autofill or Page by Page method. Autofill automatically adds
photos to the title and months pages in the order the files were
uploaded. The Page by Page method permits you to select the photos
individually for the title and months photos. Make a choice and click the
respective button.

Order Calendar Addol:e Photoshep Services Provided by
Stap: ()5elect Photos  (DSign In &) Create Kodak EasyShare Gallery

four photos are being uploaded to Adohe Photoshop Services. Once the upload s completa
wou will get a confirmation screen letting you know you are ready to create your Calendar

I ——
Figure 1-7: Wait for the upload to complete.
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& Adobe Choosa a page design for your Calendar - Windows Internat Explorar

= =FE
- ® v [y [ 3¢ || oot 2 |
Fie Ede Visw Favorites Tock Help Google |G+ :|‘_.’° () Settingsw @ Convert = [ salect

o |@Adob:(hwsupug:duignfnrym.rtalendar

v B - & v [ Page = {3 ool =

Adobe Photoshop Services

[] cesmrpeuen

& Midnight Blus T Lattice Horeydew

KOdak Wy Gabery | My Accourt | Order Status | Sign Sut | Help | Cart B =
Unitzd Shatis [Chenged

Wiew B Sdit Photos || Share Photos | Upload Photos | Buy Prints | Shep -
Choose a page design for your Calendar D Help
Selecd & slarlig munth and ane of 18 sxclusive dasgrs, Calerdars ars prinkad an bolh sides wing glssy candstod:,
Calandars maasure 10.25° « 1567 unfolde, Learn Mo
My Saved Projcts 12-manth Fhota Calendar £19.99

Startng morth:  January v 2009 w Hext

Figure 1-8: The Kodak Gallery Web page opens.

& Adobe Would you like to AutoFill your calend... [= |[E |
|® http://adobe.kodakgallery.com/PPCalAutoFillConfirm.jsp?parent_form= V|

s

KOdak Close Window

Would you like to Autofill your Calendar?

Autofill will automatically make a Calendar using all the photos
in an album of your choice. You will still be able to edit your
Calendar and rearrange photos before making your purchase.

If vou'd like the Gallery to Autofill your Calendar, click Autaofill
below, then choose your album and starting layout. Your
Calendar will be generated automatically.

If you prefer to choose your photos and page layout individually,
or if you want to use photos from different albums, click Page-
by-Page to continue creating your Calendar.

Autofill Page by Page

& Internet | Protected Mode: Off H100% v

Figure 1-9: Click Autofill or Page by Page.
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. Choose a layout.

The next Web page provides options for the layout. Choose an option
shown in Figure 1-10 and click Next.

. Add a title and identify.

The next page offers options for adding a title for your calendar and
some identifying information, as shown in Figure 1-11. Type in the text
you want and either place your order or click Preview to preview the
calendar.

. Preview the calendar.

To preview the calendar click the Preview text shown in Figure 1-11 and
the preview appears, as shown in Figure 1-12. Click the Previous and
Next buttons to preview the pages on the calendar.

. Place the order.

Click Edit in Preview and click Order when you return to the screen
shown in Figure 1-11 to place your order.

# Adobe Create your Calendar automatically - Windows Internet Explorer (E=R(CH (=:8)
@u = | retec ot kodakgallery. comPRCaLALEOF A1 j5p7 |+ | % |[ oo B~
Fie [t View Faorites Tools  Help Google |G EH.» () setings= | Comed = [ Seed
W e i) Adobe Creste your Calendar autamaticaily B o= Bl v v rEagew Gack v
Kodak - S

Unkzd Siaies [Shange]
Wiew B Edil Phalos | Share Phot Suy B Sty
Create your Calendar automatically 7 Help
Futafill generctes @ Calendar usng 2 the photos in the album of your chaice. The photas are Next

plzced in the Calendar in crdzr, from the outsics cover orwvard.

After you select vour album and lavout, chck Next to edit photos, captions and l2youts.
Album: Select an alburn or uplead new pictures,

Album from Adaba Sun Moy 09 12:06:.. .. =

[# imnort phate tities as c2ptions

Layout; |

Figure 1-10: Choose a layout and click Next.
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# Adobe Create your Calendar - Windows Intemet Explorer

[N (N oo
@\:) + | et adobe kodakgaliey.com PRCAIEARFage Jsp ad I - detected | 44 | % |[ Gomte A -
Fle [t View Fporits Tooks Help Goegle |Gl [7]}? (3 setmase | &zcoment = [El5een
W @l ) Adobe Creste you Calendar [ o= Bl v oo hEeae v STmss v

Create your Calendar 12 month Calundar (Midnight Blus). 51993 (3) Help n
Chance calsndar desiar, Swve calandar Srepwat: Cwbandar - 11/4/08
Order | | First month »
[ Zaver [= | cranse page vt |+
T YN T ANy

Figure 1-11: Type text in the text boxes for title and identity information.

# Adobe Create your Calendar - Windows Intemet Explorer

=N (N oo
@Q = | ket adobe kodakgeller.com PRCIIEIRFage Jsp adlesh < detectes |+ | % |[ oo £
Fle [t View Fpeorits Tooks  Help Google |Gl [7])? (3 setmase | zcoment = [Sl5een
W e |i) Adobe Creste your Calendar | X~ Bl v M v iEage v {3 Tools v
Create your Calendar 13 month Calundar (Hidnight Blus]. 515,59 (3) Help -
eREVIEW ol
Change calendar design

4 Frevious [edit] | Mexthk

Figure 1-12: Click the Previous and Next buttons to preview the pages.
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Assembling a Photo Collage e

To put together a photo collage, you first

. EDIT CREATE SHARE (]
need to select a few photos in the @
Organizer and then click Photo Collage g Projects ] Artwork - g'.
in the Create panel. The panel changes %‘fn
as shown in Figure 1-13. Photo Collage 3 g

(-]
i ) DEeC i N, NoOse the opi i NS fi ) your 3
The rest of the photo collage process is 1 begin, choose the options for your Z

pretty straightforward. Just choose a
layout from options displayed, pick a
theme (if you like), and then click Done. Page Size
A pop-up window opens prompting you
to log on to Photoshop.com. The remain-
ing work you perform to create a photo
collage happens after logging on to
Photoshop.com.

Letter (8.5 inch x 11 inch)

Choose a Theme (optional)

For more information on creating a
Photoshop.com account, see Book |,
Chapter 1 and Book IX, Chapter 3.

Creating a Slideshow

In Book IX, Chapter 4, we talk about
sharing slideshows online and in Book II,

Chapter 2 we cover all the options you

have for creating slideshows from within
the Organizer.

Choose a Layout

To create a slideshow using the Create

panel, first select the images you want in
the Organizer, click the Create tab in the
Panel Bin, and then click Slide Show. The Figure 1-13: Select photos in the

first thing you see is the Slide Show Organizer and click Photo Collage in the
Preferences dialog box shown in Figure ~ Create panel to open the Photo Collage
1-14. You make choices in this dialog panel.

box for setting up your slideshow —
stuff like setting transition type, transition duration, and background color.
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When you click OK in the Slide Show
Preferences dialog box, the Slide Show
Editor opens as shown in Figure 1-15,
where you define the attributes such
as editing transitions, artwork from the
Extras panel, and specifying zooms
and time codes, as we explain in Book
IX, Chapter 4.

Rather than submit the slideshow for
online viewing as we describe in Book
IX, Chapter 4, you can choose other
output options. Click the Output
button shown in Figure 1-15 and the
Slide Show Output dialog box opens as
shown in Figure 1-16. In the dialog box,
you have several options from which
to choose. These include

Figure 1-14: The Slide Show Preferences
dialog box.

1~ Save As a File. Click Save As a
File, and in the right pane you can choose from

e Movie File. Choose Movie File to export the file as a video in WMV
format.

e PDF File. Choose PDF File to export the file as an Adobe PDF
document.

 Burn to Disc. Choose Burn to Disc to write a self-running VCD
(Video CD).

1 Send to TV. Choose Send to TV to burn a DVD using one of the following
formats:

e Standard Definition (NTSC). Standard TV format using NTSC that is
supported by USA and Japanese video players

e Standard Definition (PAL). Standard TV format using PAL that is
supported by video players outside the USA and Japan

e Widescreen Definition (NTSC). Widescreen TV format using NTSC
that is supported by USA and Japanese video players

e Widescreen Definition (PAL). Wide Screen TV format using PAL that
is supported by video players outside the USA and Japan

e FEnhanced Definition. For use with TV sets supporting enhanced
definition
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e Widescreen Enhanced Definition. For use with TV sets supporting Book IX
widescreen enhanced definition Chapter 1
e Widescreen High Definition. For use with TV sets supporting o
widescreen high definition §
32
@ m
S o
o=
@
=
@

Figure 1-16: The Slide Show Output dialog box.
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Click OK in the dialog box after making the output choice, and your
slideshow is output using the settings you applied in the Slide Show
Output dialog box.

Ordering Prints Online

To order prints online using the Create panel, you must have a Kodak
EasyShare account. When you select photos in the Organizer and click
Order Prints in the Create panel, the Kodak Order Prints logon window
opens, similar to the screen shown earlier in Figure 1-6.

After you log on to Kodak Order Prints, the files you selected earlier are
uploaded and you are presented with an order page similar to the one you
see in Figure 1-17. Choose from the different print-size options and specify
the quantity for each print. As you navigate through the order process, you
can identify other recipients for your order and have copies of the prints
mailed back to you and sent to others.

Order Prints .

Order Prints erive Aeesunt: Tod Changs > Ao Photoshop Services Provided by
Step: (TTIRED O redpents  Dsummary  Dolling  (SlUplosd @) Confirmation Kodak EasyShareGallery
Salect Prints to Order Order Oplions
Add Phato »r - Matbe paper finish
Order SRR Gr  4x8 [ Singes || Deubls tapply o 3l prints)
double prinksof =g T g Doubles s Zoom and Trim (apply bo ol prints)

|| Fodsk Perfect Touch processing
Axg S045 1 £0.15 iappiy to 3l prints)
5xT L4 50.00 @ Indicates sufficient image

resciution far high
WESD Bk .80 quatityprints.Learn more, ..

Zesil’ E25 L © Indicates insulficient image
182200 g1a5s 50.00 resolution for high-qualtyprints at
20 30" $18.99 50,00 the seicched size.

4x6" 5015 50.15 P T N

P e
S5XT 5084 50,00 T Shesw Current Promation »
Walsts 5139 50,00
Brdl 5255 50.00

£0.00
50,00

163 20 51499
20% 30 518,99

46" 5013 50,15

00000000 0DOO0OOO

2] £ Gancel [ e >

Figure 1-17: The Kodak Order Prints order page.

Getting in Touch with Greeting Cards

You can create greeting cards in a snap in Photoshop Elements by using the
Greeting Card panel. Here’s how to do it:

1. Open the Organizer and select a photo.
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2. Click Create in the Panel Bin. Book IX
3. Click Greeting Card to open the Greeting Card panel. Chapter1
4. Choose a page size, theme, and layout. Q@
[1:]

In the Greeting Card panel, choose a page size from the Page Size drop- o=
down menu. Scroll the Choose a Theme window and click a theme 3.8
you want to use. Scroll the Choose a Layout window and click a layout g_ L
for your greeting card, as shown in Figure 1-18. ¢ 3

=

@

5. Size, position, and accept the edits.
Click the Check Mark icon to accept the edits.

You can size an image by dragging the corner handles on the rectangle
around the image. Click inside the rectangle to move it around the page.
When you have the size and position you want, click the Check Mark
icon to stamp down the image.

6. Click the Text tool on the Tools panel and add some text, as shown in
Figure 1-19.

For more on adding text to photos in Elements, see Book V, Chapter 3.

7. Click Done and choose File=>Save to save the file.

Figure 1-18: Choose a page size, theme, and layout for your greeting card.
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Greetings from Tagum

Figure 1-19: Add some text to your greeting card by clicking
the Type tool and then clicking the photo.

Making Photo Stamps

Another online creation feature in Elements is the option to create your own
personal postage stamps. Yes, they're real stamps that you can use for mail-
ing though the post office.

Here’s the simple, easy way to use Elements to place an order for your very
own personal postage stamps:
1. Select an image in the Organizer.

Your file needs to be less than 5MB. (See Book III, Chapter 1 for more on
resizing images.)

2. Click Create in the Panel Bin, and then choose PhotoStamps from the
More Options drop-down menu.

The PhotoStamps dialog box opens.

3. Click the Upload My Photos button in the dialog box (see
Figure 1-20).

Your photo is uploaded to the PhotoStamps.com Web site.
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NOtc m .
Pho ,E?j}:ae ME:? vou. Adobe Photoshop Services
: |\ Turn your favorite photos into your
= | 5 5 s!
A | very own postage stamps

It's easy...

Upload your phote
#=) Customize your design
%) Place your order

Figure 1-20: Choose Postage Stamps from the Create panel’s
More Options drop-down menu to open this dialog box.

4. Place your order.

The PhotoStamps.com Web site provides an easy-to-use interface for
ordering stamps. After you fill out the order and provide billing informa-
tion, your stamps are mailed to you.

Getting Organized with CD/DVD Labels

ANG/
&>

Another creation option in Elements is a simple, easy way to create CD and
DVD labels. From the Create panel, choose a menu item for CD Jacket, DVD
Jacket, or CD/DVD Label from the More Options drop-down menu. From tem-
plates provided in the panel, Elements offers you an easy method for print-
ing your own, personalized labels and jackets for CDs and DVDs.

This feature for printing CD/DVD labels is a bit weak in Elements. You may

need to fiddle around quite a bit to get the images to fit a label. Using some
templates provided by the label developers is often a much better method

for printing labels.

Creating a UCD with Menu

Select a slideshow project and open the Create panel. From the More
Options drop-down list, choose VCD with Menu. The Create a VCD with
Menu dialog box opens as shown in Figure 1-21. Select a project, make a
choice for NTSC or PAL format, and click Burn. The file created is a Video CD
with a menu you can control with your DVD player’s remote control device.
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sjyuawa|j Huneas)



556

Making a Flipbook

Figure 1-21: The Create a VCD with Menu dialog box.

Making a Flipbook

At the bottom of the More Options drop-down menu in the Create panel,
you can find a command for Flipbook. If you want to create a quick little
video that shows off your photos by flashing stills on your screen or your
TV set, you can quickly create a flipbook. Here’s how you do it:

1. Open the Organizer and select the files you want to use.

Note that you must select at least two files in order to create the flipbook.

. Click the Create tab in the Panel Bin and choose Flipbook from the

More Options drop-down menu.

The Photoshop Elements Video Flipbook dialog box opens, as shown in
Figure 1-22.

. Set the playback speed by typing a value in the Speed text box or

moving the slider to the desired speed.

Note that flipping through photos looks best at low speeds, such as one
or two frames per second (fps). Also, you can select the size for your
video file from options on the Movie File Size drop-down menu. As file
sizes are reduced, the download speeds when sharing files on the
Internet increase. To get familiar with the file size that works best for
you, experiment a little by saving files at different sizes.
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4. Click Output. Book IX
. . . Chapter 1
The Save Video Flipbook dialog box opens.

5. Type a filename and click Save. s
=]

Your file is written as a .wmv file. You can use Microsoft Movie Maker to EE]
write the file to a CD or DVD. e'm
53

(-]

=

«

Figure 1-22: The Photoshop Elements Video Flipbook dialog box permits
you to select a speed and movie file size.

The WMV format is not recognized by many DVD players. You may need to
convert the file format to a format recognized by your DVD player. Do an
Internet search and explore some Web sites that offer freeware or shareware
conversion utilities to learn more about video file formats acceptable to
DVD players.
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